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Welcome & Introduction
Congratulations! You are working with award-winning legal billing and practice management
software.

Purpose of Guide
This Installation Guide covers installing the software. It includes information on basic concepts that
are important to individuals who are responsible for the installation of the software and maintenance
of the computers and network on which the software is installed.

More Info
In addition to this Installation Guide, the following resources are available:
Guides

A separate Administrator Guide includes information for configuring and setting up
the software. Additional guides for separate software features are also available. All
guides are available on our Web site at Tabs3.com/support/docs.html

Knowledge You may be referred to additional detailed information located in our Knowledge Base
Base
on the Internet at:

support.Tabs3.com
Additional A comprehensive list of all resources for Tabs3 software can be found on page 42.
Resources

Customer Service is Important
We understand that customer support is an important part of customer satisfaction. When you
purchase a Tabs3 or PracticeMaster software license, you have our assurance of customer service
and product support. Product support plays a key role in our customer service philosophy. Our
Technical Support staff is dedicated to helping you get the most from the software by answering
technical questions about the product and how it works.
If you have a question or problem concerning the software, we recommend these steps:
1. Check the product documentation including the Help provided with the software. Often,
you’ll find the answer to a question there. To view Help, you can press F1 or select Help |
Help Topics while in the software.
2. Refer to our Knowledge Base on the Internet. Our Knowledge Base contains extensive
information on Error Troubleshooting, Networking & Windows Issues, “How To” Articles and
Product-Related Articles. Our Knowledge Base can be launched from the Help | Internet

-1-

Tabs3 Software Installation Guide

Resources | Knowledge Base menu options in the software or found at:
support.Tabs3.com
3. Consult the consultant from whom you purchased the software license. If you can’t find the
answer in the product documentation, your consultant may be able to assist you.
4. Call our Technical Support Department at (402) 419-2210. Before you make the call, gather all
information pertaining to the problem. We will need to know the serial number of the
software, which can be found via the Help | About menus in the software.

Introducing Tabs3 Software
Tabs3 software provides an integrated front office and back office solution. The front office software
is PracticeMaster. The back office software consists of Tabs3 Billing Software and the Tabs3 Financial
Software, which is comprised of Tabs3 Trust Accounting (TAS), Tabs3 Accounts Payable (APS), and
Tabs3 General Ledger (GLS).
Tabs3 software consists of the following products:
Tabs3 Billing

Tabs3 Billing is the award-winning industry standard for
legal billing software.

PracticeMaster

PracticeMaster is a complete practice management system
that helps your law firm find case, client, and contact
information, and find it fast. PracticeMaster includes
powerful firm-wide calendaring, conflict checking,
reporting, document assembly features, tracking for online
research, email, documents, and phone calls, and more.

Tabs3 Trust Accounting (TAS)

Tabs3 Trust Accounting is designed to help your firm keep
track of the trusts you manage. TAS allows computer
check writing from 99 different bank accounts as well as
manually written checks. A bank account reconciliation
program is included. IRS Form 1099-MISC information can
be printed in TAS or combined with APS 1099-MISC
information.

Tabs3 Accounts Payable (APS)

Tabs3 Accounts Payable automates payables, keeps track
of vendor discounts and recurring payables, accumulates
amounts for IRS Form 1099-MISC, and allows computer
check writing and manual checks.
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Tabs3 General Ledger (GLS)

Tabs3 General Ledger is designed to let you use your
existing chart of accounts and select the financial
statement formats you desire. It includes a Reconciliation
program to help you balance GLS with your bank
statement or credit card statement. Financial statements
can be run for any period.

System Configuration

System Configuration is used to configure users,
passwords, groups, access profiles, and firm information.
The Administrator Guide includes steps for configuring
this information.

Because the software is integrated, there are no separate synchronizations that occur or links that
need to be configured.

Platinum Software
The Platinum versions of Tabs3 software are the top of the line products offered by Software
Technology These programs utilize state of the art database technology to ensure the fastest
performance and lowest network impact possible. They also include advanced reporting options,
administrative tools and mobile access to your Tabs3 Billing and PracticeMaster data.
Platinum Server software is used with the Platinum version and is installed automatically.
Additional configuration information for the Platinum version can be found on page 17.

Hardware Requirements
To use Tabs3 software, the following software and hardware is required:
l

l

Windows 10/8/7, Windows Server 2016/2012/2008 R2 (including Windows Server 2012 R2 and
Windows Small Business Server 2011).
Minimum processor speed and system memory requirements are the same as your operating
system requirements.

l

1024 x 768 or higher screen resolution using 100% text size (i.e., 96 dpi).

l

32-bit color is recommended.

l

l

The entire suite of Tabs3 products requires less than 300 MB for program files. Additional disk
space is required for data files.
High speed wired network recommended. Wireless networks are not recommended due to
performance and reliability issues.

l

Training videos require Adobe® Flash® Player 10 or later for Internet Explorer.

l

Internet access recommended.
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l

Information regarding integration with third-party applications such as Microsoft®
Outlook®, Microsoft® Word, Worldox®, CalendarRules™, PenSoft® Payroll, QuickBooks®,
and more can be found in Knowledge Base article R11752 – Third Party Integration
Requirements.

Operating System Environment Notes
Tabs3 is only tested in a Windows environment. We do not test, support, or recommend hosting the
Tabs3 software on any computer or device running an operating system other than those listed.
l

l

l

l

l

l

Tabs3 can be run on a virtual machine.
Tabs3 can be used on a hosted server or via remote access. See R11722 - Tabs3 Cloud
Options and R11721 - Hosting Tabs3 Software in the Cloud.
Tabs3 can be run under Remote Data Services (RDS) or Citrix. See R11284 - Using Tabs3 and
PracticeMaster Software on Terminal Services or Citrix.
Technically, you can run Tabs3 software on a file server that supports the Server Message
Block (SMB) network protocol for file sharing, such as a Network Attached Storage (NAS)
device. However, non-Windows operating systems may handle file sharing in ways that differ
significantly from a Windows server. This can lead to fatal errors and network issues that we
will not support.
Do not install or use Tabs3 software on cloud applications or backup services that
synchronize across devices, such as Dropbox, OneDrive, Google Drive, Box, Amazon Cloud
Drive, etc. These types of applications are not designed to handle database applications that
update multiple files at the same time for a single transaction.
Domain Controller Note: Installing the Tabs3 software database on a domain controller may
require special IT consideration due to potential performance issues. Windows Server
Essentials/Small Business Servers are always domain controllers, and any Windows server can
be configured as a domain controller. Additional information can be found in the "Using a
Domain Controller as the Tabs3 Server" section of R11637 - Network Performance Guide.

Platinum Requirements
The following additional system software and hardware is required for the Platinum Server computer.
l

l

Platinum Server software.
Platinum versions of the software (i.e., 90000 series serial numbers or 95000 for Platinum SQL
Server).

l

A multi-core processor is recommended.

l

2GB RAM is the minimum recommended memory for the Platinum Server.
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l

l

Ensure that plenty of free disk space is available. Temporary files created on the server can be
quite large. Minimum free space of four (4) times the data set size is recommended. Each
HotBackup requires enough disk space for the entire data set.
Windows Server: Microsoft Windows Server 2016, Microsoft Windows Server 2012 R2,
Microsoft Windows Server 2012, Microsoft Windows Server 2008 R2, Windows Small Business
Server 2011 (either 64-bit or 32-bit version), Windows 10, Windows 8, or Windows 7.
Recommended that all current Service Packs be installed. A 64-bit operating system is
required for Platinum SQL Server.
Note: When running the Platinum Server on a non-server operating system (i.e., Windows
10/8/7), you are limited to the number of concurrent connections and may exceed the
connection limit in that operating system.

l

l

l

Platinum Exchange Connector: If using the Platinum Exchange Connector, refer to
Knowledge Base Article R11596, Configuring the PracticeMaster Platinum Exchange
Connector, for specific installation requirements.
Workstation: Windows 10/8/7. Recommended that all current Service Packs be installed.
High speed wired network recommended. Wireless networks are not recommended due to
performance and reliability issues.

Additional Information Regarding Platinum Requirements
Platinum Version software is designed so that it can run on modest server hardware but can take
advantage of more powerful servers.
l

l

l

l

l

l

Adding RAM to a server is the least expensive way to improve server performance. While
Platinum will run on a 512MB server, at least 2GB RAM is recommended for best
performance.
The maximum amount of memory that can be allocated to the 32-bit Platinum Server is 0.8
GB on a 32-bit server and 2.0 GB on a 64-bit server. These limitations do not apply to the 64bit Platinum SQL Server.
Using Accelerator technology in Platinum, the faster the server’s CPU(s), the less time it takes
to process reports. A multi-core processor is recommended.
If running Platinum Server software on a virtual machine, we recommend allocating multiple
cores to the Platinum Server for best performance.
In order to use HotBackup, your server must have enough free disk space to hold copies of
the entire data set. You control the number of copies to keep but you must have enough free
space to hold at least three full copies.
The faster the server’s disk subsystem is, the less time it takes to perform a HotBackup. Also,
for best HotBackup performance, configure the source and destination folders on different
spindles (i.e., drives).
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l

A Microsoft Server operating system is recommended (e.g., Microsoft Server 2016, 2012, or
2008). Using a non-server operating system such as Windows 10, Windows 8, or Windows 7
will work, but they were not designed as server operating systems and have some limitations,
such as concurrent connections.

Integration Requirements
Our Knowledge Base includes information regarding versions required when integrating with other
software such as Outlook, QuickBooks, Worldox, and more. The following Knowledge Base article
provides an overview of the specific versions and releases of third party applications currently tested
and supported that integrate with Tabs3 software.

R11752 - Third Party Integration Requirements

-6-

Tabs3 Software Installation Guide

Preliminary Information
Data Location
When using the software on a network, all program and data files must reside on the file server.
Workstations run a setup program that installs another copy of the program files on their computer
in a local program directory. However, the workstations access the data files on the server. Only one
set of data files exists for the software (i.e., each workstation does not have a separate set of data
files). The directory in which the data files reside is referred to as the Current Working Directory. All
data files reside on the server in the same directory as the program files.

Figure 1, Files Installed on the Server and Workstations

Note: We do not recommend installing the Tabs3 software to Cloud applications that synchronize
files across devices, such as Dropbox or other Cloud applications. These types of applications are
not designed to handle database applications that update multiple data files at the same time for a
single transaction.

Access Rights
All users must have all rights to the program and data directories.
When installing the software on the server or workstation, you must have Administrator privileges.
Additional details regarding these requirements can be found in our Knowledge Base on the Internet
in Article R11434 - “User Rights Needed to Install and Use Tabs3 and PracticeMaster Software” at
support.Tabs3.com.

Rights Required for PracticeMaster Plug-ins
Required settings are written to the windows registry for various PracticeMaster Plug-in features.
Therefore, in order to successfully use these features, the feature must be installed by a user who has
Administrator credentials. If you are running the software without these credentials, you will be
asked to enter them at the time they are required. Once the Windows registry has been appropriately
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modified when an administrator starts or installs the Plug-in, it is no longer necessary for the user to
have Administrator rights. These features include:
l
l
l
l
l
l
l
l
l
l
l
l

Outlook Plug-In for email integration
Internet Explorer Plug-in
Word Plug-in
Excel Plug-in
PowerPoint Plug-in
Adobe Plug-in
WordPerfect Plug-in
HotDocs Document Assembly Plug-in
Word Document Assembly Plug-in
Worldox Plug-in
Windows Explorer Plug-in
ScanSnap Plug-in

Bandwidth and Server Activity
Tabs3 software, like other accounting and bookkeeping data processing software, is more
bandwidth intensive than general business software. The data entry and report processing functions
in the software generate significantly more traffic on a network than word processing or spreadsheet
programs, for example. As a result, there are several best practices we recommend, such as not
running the software in a wide area network (WAN), excluding the directory from continuous antivirus scanning, and more.

Best Practices
We recommend the following best practices for using Tabs3 software.

Wireless Networks
Data processing software, such as Tabs3 software, is very disk I/O intensive. The software is
constantly opening files, writing to them and closing them across the network. The software also
makes frequent use of temporary files. For these reasons, the potential for Tabs3 software
encountering network connection errors is much greater than other types of software such as word
processing software. Applications such as Microsoft Word do not send data across the network like
data processing software, and therefore are not good choices for comparing frequency of network
connection errors.
As a result, we recommend using a high speed wired network. Wireless networks are not
recommended due to performance and reliability issues.
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Wide Area Networks (WAN)
Transaction-based software, such as Tabs3 and PracticeMaster, is designed to operate in a LAN
environment, where the network speed is consistent and the connection is stable. Attempting to
connect a remote workstation installation directly to the server via a WAN will result in poor
performance and dropped connections, which will in turn cause fatal errors and possible data loss.
The best way to avoid these issues is to use a WAN to remotely access a physical or virtual
workstation instead. Knowledge Base Article R10436, “Comparing Network and Cloud Options for
Tabs3 Software,” includes multiple methods for allowing off site users to access the Tabs3 and
PracticeMaster software.

Antivirus Scanning
Some virus checking software has the ability to continuously virus scan any files that are accessed
on the hard drive. This type of configuration can slow down the performance of software,
particularly in a network environment. Because Tabs3 software is very disk I/O intensive, the
potential performance decrease caused by continuous virus scanning may be more apparent in our
software than in some other types of software.
There have been reports of virus checking software adversely affecting performance and sometimes
even causing runtime errors. For optimum performance, we recommend that virus checking software
be configured in such a way as to minimize the effects of virus scanner interference.
l

l

l

Firms who have disabled continuous virus scanning have reported significant improvements
in performance and access times.
If you are using continuous virus scanning software and you have it configured to scan all
files, consider changing the configuration so that it excludes the following files in the Tabs3
and PracticeMaster Current Working Directory and its subdirectories: *.DAT, *.IDX, *.TMP,
*.LOG. (Note: You can find the location of the Current Working Directory in the Help | About
window in any of the Tabs3 software.)
Platinum Note: Users with Platinum software must also exclude *.FCS files.
For optimum performance, consider excluding the Tabs3 and PracticeMaster directories from
continuous virus scanning software (i.e., the Current Working Directory and all its
subdirectories). These directories can be virus checked in a full disk scan during non-peak
usage times.
Platinum Note: Users with Platinum software must exclude *.FCS files when performing a
scan on demand.

Knowledge Base article R10760, Antivirus Software Information, includes additional information and
recommendations.
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Email Virus Checking Software
Some newer antivirus software has the ability to monitor TCP/IP traffic in order to locate email
viruses. However, in some instances, this scanning will decrease the speed of the workstation upon
which that antivirus program is running, as using any MAPI-compliant email system (e.g., Outlook)
will cause the antivirus program to attempt to intercept viruses by monitoring TCP/IP traffic.
Depending on settings for the computer and email program, monitoring the TCP/IP traffic can
require a great deal of computer resources and introduce slow downs in other software. There have
been reports that performing an install of Symantec AntiVirus without any of its built-in email
scanners will resolve the problem.
Often, performing steps to disable active scanning will also disable active email scanning, but this is
not always the case. One way to test if the antivirus program is causing the speed decrease is to
temporarily disable the antivirus program. If response times improve, and the settings above have
been corrected to exclude the Tabs3 Current Working Directory from continuous virus scanning, the
email scanning may be causing the issue. While temporarily disabling your email integration may
improve the system speed, we recommend you contact your antivirus provider to determine what
options are available for email scanning.

Offline Files Not Supported
Tabs3 software does not support Offline Files. If Offline Files are enabled, you must disable Offline
Files before you can use the Tabs3 software. Details regarding Offline Files can be found in our
Knowledge Base in Article R11450, Offline Files Not Supported in Tabs3 and PracticeMaster
Software.

Starter Data
Starter data is provided with Tabs3 Billing, PracticeMaster, and Tabs3 General Ledger Software (GLS).
During the installation process, you will be asked if you want to install a starter set of data.

We recommend installing the starter data.
Starter Data Sets simplifies the initial setup process by predefining information in various setup files
such as transaction codes, categories, text macros, etc. If you select this option, a partial set of data
files will be installed. If any of the data files being installed are already present, the corresponding
starter data files will not be installed. These files may be modified as desired.
Tabs3 Billing Starter Data

The Tabs3 Billing Starter Data Set consists of the following
files.
l
l
l
l

transaction codes
categories
billing frequencies
statement templates
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l
l
l
l
l
l
l
l

email templates
text macros
task based billing codes
timekeeper levels
task code set names
cost type descriptions
statement notes
statement designer layouts

The Tabs3 Billing Report Pack includes printouts of
these files.
Note: The task based billing codes, task code set names,
timekeeper levels, and cost types are installed even if you
elect not to install the Starter Data Set (unless the files
already exist in either Tabs3 Billing or PracticeMaster).
PracticeMaster Starter Data

The PracticeMaster Starter Data Set consists of the
following files.
l
l
l
l
l

transaction codes
calendar codes
categories
text macros
task based billing codes

The PracticeMaster Report Pack includes printouts of
these files. The PracticeMaster Starter Data set also
includes predefined Report Writer report definitions. Area
of Practice Templates are not included in the Starter Data.
GLS Starter Data

The Tabs3 General Ledger (GLS) Starter Data Set consists of
the following files:
l
l
l

chart of accounts
journal names
departments

The GLS Report Pack includes printouts of these files.
Note: If data for the product being installed already exists, you will not be given the option to
install starter data.
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Note: If installing PracticeMaster over an existing Tabs3 Billing installation, the mirrored data files
will not be installed (i.e., categories, transaction code, text macros, task based billing codes).
However, calendar codes and PracticeMaster Report Writer report definitions will be installed.
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Installing the Software
Installing the software consists of two steps:
l

Installing the software on the server; and

l

Installing the software on each workstation that will be using the software.

Installing the Software
The software is provided via download and must be installed to a hard disk.
Note: You must have Administrator privileges when installing the software.
Platinum Note: If installing the Platinum version of the software, the software must be installed
from the server itself.
▶ To install the software via Internet download
1. Go to www.tabs3.com/install.
2. Download and install the software.
3. Certain installations require an Activation Code. If an Activation Code is required, you can
copy and paste it from the email your invoice was attached to.
Note: Activation Codes are valid for 30 days. Contact Technical Support if you need a new
Activation Code.
Note: During the installation, a file named READWSTI.HTM is installed. This file contains
information regarding the software that may not appear elsewhere in the documentation.
Note: Instructions for other installation scenarios can be found on page 34.

Installing the Software on Network Workstations
Once the Tabs3 software has been installed on the file server, each workstation that will be using the
software must run the SETUP.EXE program file located on the file server. The SETUP.EXE program on
the file server is the workstation installation program. This program installs program files, help files,
and desktop shortcuts onto the workstation.
Note: When running SETUP.EXE, you must have Administrator privileges.

- 13 -

Tabs3 Software Installation Guide

▶ To install the software on a workstation
1. From the workstation, browse to the Current Working Directory on the server and run
SETUP.EXE.
2. SETUP.EXE will launch a setup wizard. Follow the on-screen instructions to complete the
workstation installation.
3. Repeat the above steps for each workstation that will be using the software.
Note: When running SETUP.EXE, the program will automatically change the rights in the specified
local program directory to full read/write rights for all users. The SETUP.EXE does not change rights
on the server.
Note: Additional information about the network installation can be found in Knowledge Base
Article R11229 - “All About the Local Install (SETUP.EXE) and Auto Update”.

Terminal Services Considerations
When running under Terminal Services or in a Citrix environment, the SETUP.EXE file will only need
to be run once by a Terminal Services computer, no matter how many users log onto the workstation
remotely. The following will need to be performed for each Terminal Services computer. Before
running SETUP.EXE, delete any shortcuts to the Tabs3 Software programs for each user on the
workstation. Once SETUP.EXE is complete, a single set of desktop shortcuts will have been created.
These desktop shortcuts will need to be copied to all other users’ Desktop directory, which for
Terminal Services in Windows 10/8/7 is C:\users\<userID>\Desktop. (Note: Locations may be
different for Citrix). Once the shortcuts have been copied to all other users’ desktops, delete the
shortcuts from the All Users directory (otherwise users will have two sets of shortcuts). Once users
have their own shortcuts, they are free to add startup options as desired. Later, when the Tabs3
Software programs are updated on the server from the Web, an Administrator must open any Tabs3
Software program on the Terminal Server to update the program files on the Terminal Services
computer. It is not necessary to run SETUP.EXE again, because the local program files will
automatically update when the software is started.
Note: Additional information about using Tabs3 software on Terminal Services or Citrix can be
found in Knowledge Base Article R11284 - “Using Tabs3 and PracticeMaster Software on Terminal
Services or Citrix”.

Installing Platinum
The Platinum version of the Tabs3 software requires additional configuration. The Platinum
Configuration section of this document (page 17) provides basic information your IT person needs
to know.
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Starting the Software
Starting the Software
The software can be started via a shortcut icon on the Windows desktop or via the Windows taskbar.
If you already have a Tabs3 application started, you can launch another Tabs3 application using the
application toolbar.
Desktop
Shortcut

During installation, if you elected to create icons on the desktop, you can
double-click the associated desktop icon.

Windows
Taskbar

The software can be started via the Windows taskbar.
Click the Start button, and then point to Programs.
Point to the Tabs3 & PracticeMaster folder and then
click the menu option for the desired software product.

Application The application toolbar provides the ability to quickly start
Toolbar
other Tabs3 software. Positioning the mouse over any
application toolbar button will display the software associated with that button.

Logon
After starting the software, the Logon dialog box will be displayed. No User ID is required. Simply
leave the User ID and Password fields blank and click OK.

Figure 2, Logon window

Best Practice: After users have been added to the software using System Configuration, we
recommend either deleting the [BLANK] user ID, or marking it inactive.
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Customization
When the software is first started, the Customization window will be displayed. Complete details
regarding Customization can be found in the Administrator Guide. We recommend using this
guide and working with the Firm Administrator to determine the desired configuration options
before adding clients or other data.

Exiting the Software
To exit the software, you can use one of the following methods:
l

From the File menu, click Exit

l

Click the Close button on the titlebar
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Platinum Configuration
The Platinum version of the Tabs3 software has additional features. Because of the increased level of
sophistication required to implement these features, additional configuration is required. This
section of the guide includes information on firewalls, configuring and operating the Platinum
Server, configuring HotBackup, configuring Tabs3 Connect, configuring the Exchange Connector,
and configuring Platinum SQL.
Note: If you are not installing the Platinum version, skip to page 32.
More Info: Complete information regarding Platinum can be found in the Platinum Server
Product Guide.

Firewall Ports
A firewall is a software program or hardware device that secures your computer by blocking
incoming network communications.
Platinum Server software includes components that run on the server computer, but need to receive
communications from other computers on the network. These components are STI Director and the
Tabs3 Billing and PracticeMaster Accelerators. For example, STI Director is assigned (by default) to
port number 1779 on the server computer. Therefore, any TCP/IP communications received by the
server computer with an “address” of port 1779 are immediately routed to STI Director.
It is common for a server computer to be protected by a firewall that blocks access to all but the
most critical ports. Because of this, you will need to verify that the ports required by STI Director and
the Tabs3 Billing and PracticeMaster Accelerators are unblocked (i.e., open). These port numbers are
defined in the System Configuration program, on the Director Configuration tab of the Platinum
Server Configuration window (Platinum | Platinum Server Configuration).
By default, the following ports are used by the various Platinum Server components:
l
l
l
l
l
l

Port 1779 - STI Director
Port 1780 - Tabs3 Billing Accelerator
Port 1781 - PracticeMaster Accelerator
Port 5807 - Platinum Server
Port 1621 - Tabs3 Connect (Outgoing only, normally open by default.)
Port 6597 - Platinum SQL

Opening these ports will allow STI Director and the Tabs3 Billing and PracticeMaster Accelerators to
receive necessary communications from the workstations on the network. Additional information,
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including specific information on Windows Firewall can be found in our Knowledge Base in Article
R11197 - “Opening Ports in Windows Firewall” at support.Tabs3.com.
Note: These ports are automatically opened on the server when the installer creates the STI Server
Service and STI Director service. This typically occurs during the initial installation or when running
a software update after moving the Tabs3 and PracticeMaster software to a new server. If the
services are already in place, the installer will not open the ports.
Note: If your firm uses a hardware-based firewall to connect to the Internet, it is critical that you
do not open these ports to Internet traffic.

Configuring & Operating Platinum Server
If you chose to install the Platinum Server as a Windows Service during the Tabs3 Software
installation, there is no additional configuration necessary to operate the Platinum Server. If you
chose not to install the Platinum Server as a Windows Service, see the “Operating Platinum Server“
section of the Platinum Server Product Guide for information on configuring the Platinum Server.

Configuring HotBackup
Configuration of HotBackup is done in the System Configuration software program. These
configuration settings are located in the Platinum Server Configuration window (Platinum |
Platinum Configuration). After installing the Platinum Server software, you will need to review the
settings on the HotBackup Folder tab of this window. You may choose to keep these settings, or
you may modify them to better suit your needs.
More Info: Detailed information regarding individual settings is available in the Help provided
with the System Configuration software.

Platinum Server Configuration
The Platinum Server Configuration window (Platinum | Platinum Server Configuration) is
accessible from the System Configuration software program.
This window contains all settings related to HotBackup, STI Director, and the Tabs3 Billing and
PracticeMaster Accelerators. The following is a brief overview of the Platinum Server Configuration
window. Detailed information regarding individual settings is available in the Help provided with the
System Configuration software.
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HotBackup Schedule

The HotBackup Schedule tab (Figure 3) displays a list of
scheduled HotBackups. It is used to create or delete
scheduled HotBackups, as well as temporarily suspend
scheduled HotBackups. HotBackups can be scheduled for
varying times of the day on weekdays, every day of the
week, or specific days of your choosing.

Figure 3, HotBackup Schedule tab

Schedule Recurring HotBackups

The Schedule Recurring HotBackups window (Figure 4) is
used to schedule one or more HotBackups. It is accessed
via the Schedule Recurring HotBackups button on the
HotBackup Schedule tab (Figure 3).
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Figure 4, Schedule Recurring HotBackups

HotBackup Notification

The HotBackup Notification tab (Figure 5) is used to
configure email messages that can be sent automatically
to various recipients in the event a HotBackup fails or
succeeds. Selectable variables allow unique descriptions
and subject lines to be created automatically when a
message is sent.
Note: Configuring email messages to notify recipients of
successes and failures provides a powerful built-in
safeguard feature. We recommend that at least one email
message be defined for failures so that the appropriate
personnel are notified in the event there are problems.
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Figure 5, HotBackup Notification tab

Outgoing Email Configuration

The Outgoing Email Configuration window (Settings |
Outgoing Email Configuration) (Figure 6) is used to
configure the settings necessary to send email messages. It
is accessible from the System Configuration software
program.

Figure 6, Outgoing Email Configuration
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Notification Message

The Notification Message window (Figure 7) is used to add
a new email message, or edit an existing one. It is accessed
via the Add New Message and Edit Message buttons on
the HotBackup Notification tab (Figure 5).

Figure 7, Notification Message

HotBackup Folder

The HotBackup Folder tab (Figure 8) is used to configure
the location where HotBackups are stored, as well as the
number of HotBackups to maintain at one time. By
default, the HotBackup Folder is defined as
“C:\HotBackup”, and the Number of Successful
HotBackups to Keep is set at 4 Recent and 2 Archive (i.e.,
6 total). Valid syntax for the HotBackup Folder is:
[driveletter]:\[foldername]
Detailed information regarding these settings can be
found in the Help provided with the System Configuration
software. The “Directory Structure” section of the
Platinum Server Guide also provides additional
information on these settings.
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Figure 8, HotBackup Folder tab

Director Configuration

The Director Configuration tab (Figure 9) is used to
configure various options for STI Director and the Tabs3
Billing and PracticeMaster Accelerators. The default
settings are determined when the Platinum Server software
is first installed.

Figure 9, Director Configuration tab

- 23 -

Tabs3 Software Installation Guide

Server Cache

The Server Cache tab (Figure 10) is used to determine the
amount of server memory allocated to caching Tabs3 and
PracticeMaster data and index files. This option should be
configured as soon as possible to maximize performance.
See Knowledge Base Article R11644, “CTSRVR.CFG
Configuration File,”or the Platinum Server Guide for more
information on configuring this tab.

Figure 10, Server Cache tab

Configuring Tabs3 Connect
Tabs3 Connect is a Web-based application that allows Platinum users to sign in to an easy-to-use
interface for their Tabs3 and PracticeMaster data. Tabs3 Connect allows touch or mouse-based
interaction, and is designed to work with both handheld and tablet (or larger) screen formats. The
Tabs3 Connect program (T3CONNECT.EXE) runs on your server and registers your users with the
Tabs3 Connect site. More information regarding Tabs3 Connect can be found in Knowledge Base
Article R11480, “All About Tabs3 Connect”.
Tabs3 Connect must be configured to allow users to log in to the Tabs3 Connect Web application.
Configuration consists of the following three steps:
l
l
l

Enabling Tabs3 Connect for the Firm
Configuring Access Profiles to Administer Tabs3 Connect Users
Configuring Users to Access Tabs3 Connect
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Tabs3 Connect Subscription Note: If you will be accessing Tabs3 Connect using a Tabs3 Connect
Billing license, PracticeMaster Basic must be installed and configured prior to enabling Tabs3
Connect. Knowledge Base Article R11027, “Installing the Try Before You Buy PracticeMaster
License“ includes step-by-step instructions for installing and configuring PracticeMaster Basic.
From the Help menu, select Check for Updates to download the most recent software update.
▶ To enable Tabs3 Connect for the Firm
1. Start System Configuration.
2. From the Platinum menu, select
Tabs3 Connect Administration.
3. Select Allow connections via
Tabs3 Connect.
4. Specify the timeout value in the
Automatically log users off after
XX minutes field (default is 10
minutes).
5. In the Notices section, enter the
Email Address where you want
important email messages sent
regarding Tabs3 Connect
including downtime periods,
maintenance expiration, and
other important communications.
A valid email address is required.
Figure 11, Tabs3 Connect Administration window
a. Press Ctrl+S to save your
changes.
b. Click the Test Email button. A message will be displayed stating, “You should receive
an email from Tabs3 Connect shortly.”
c. Verify the email message was received by the designated recipient.
6. Click the Start button to start Tabs3 Connect. Tabs3 Connect is ready to use once the status
indicators change as follows:
l
Tabs3 Connect Status: Running
l
Connection Status: Connected
7. Close the window.

- 25 -

Tabs3 Software Installation Guide

Firewall Note: Depending on your settings, you may need to configure your network so that
outgoing connections via port 1621 are not blocked by a firewall. By default, most firewall settings
do not block outgoing connections; therefore, most firms do not need to make any firewall
changes. However, if port 1621 is blocked to outgoing connections, it must be opened to permit
communications between the server and client software. KB Article R11197, “Opening Ports in
Windows Firewall”, discusses firewalls and provides steps for checking and modifying the firewall
settings for those firms whose servers use the Windows Firewall.
▶ To configure access profile(s) to administer Tabs3 Connect users
1.
2.
3.
4.

Start System Configuration.
From the File menu, point to Open and then select Access Profile.
Select the Access ID to which you will grant rights to administer Tabs3 Connect users.
Under System Configuration Access, select the Tabs3 Connect Access and Settings check
box.
5. Press Ctrl+S to save the Access Profile.

Figure 12, Access Profile window
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Note: The above procedure is not used to grant users access to Tabs3 Connect, but is used to
designate which users have rights to change the Tabs3 Connect settings on behalf of users
(themselves or others).
▶ To configure users to access Tabs3 Connect
1.
2.
3.
4.
5.
6.

Start System Configuration.
From the File menu, point to Open and then select Users (Figure 14).
Select the User ID who will be accessing Tabs3 Connect.
Verify that the user has a valid Email Address configured. (Note: This field is required.)
In the Options section, select Allow access via Tabs3 Connect.
Click the Tabs3 Connect Settings button and enter the following information in the Tabs3
Connect Settings window (Figure 13):
a. In the Feature Access section, specify whether the user will access Tabs3 Connect
using Billing and PracticeMaster features or just Billing features. If your license is for
PracticeMaster only features, you must select the Billing and PracticeMaster option.
See Knowledge Base Article R11480, “All About Tabs3 Connect“ for information on
the differences between Billing and PracticeMaster and Billing access levels.
b. Enter a strong password in the Password and Confirm Password fields. The
password must be at least 8 characters and it must have at least one capital letter, one
lowercase letter, and one number.
c. Select the Fee Timekeeper for which new fees will be assigned while logged in to
Tabs3 Connect. (Note: Users who are assigned to one or more Tabs3 Billing and
PracticeMaster Timekeepers must select one of those timekeepers as their Fee
Timekeeper.)
d. Select the Default Start Page for using Tabs3 Connect. For example, some users may
prefer to always start Tabs3 Connect with the Home page, while others may prefer to
start with the Matter Manager page.
e. Select the preferred Text Macro Default setting. This setting determines the default
behavior when accessing Tabs3 Connect. Text Macros can be toggled on and off
during the session according to the user’s preference. See Knowledge Base Article
R11682, “Using Text Macros in Tabs3 Connect” for more information.

7.
8.
9.
10.

Click OK.
Press Ctrl+S to save the changes to the user record.
Repeat steps 3-8 for each user who requires access to Tabs3 Connect.
Next, if using PracticeMaster, you may want to grant rights for downloading files via Tabs3
Connect. This right is granted using the access profile. You may want to add a new access
profile or grant the right to one or more existing access profiles. To grant the right to an
existing access profile:
a. From the File menu, point to Open and then select Access Profile.
b. Select the Access ID to which you will grant rights for users to download files from
Tabs3 Connect.
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c. Click the PM tab (Figure 15).
d. In the File Information section, select the Download Files via Tabs3 Connect
function.
e. In the Selected Functions section, click Allow.
f. Press Ctrl+S to save the Access Profile.
Note: The number of users that can be configured for Tabs3 Connect access is limited to the
number of users for your PracticeMaster license plus the number of users for your Tabs3 Connect
Billing license. More information on Tabs3 Connect licensing can be found in Knowledge Base
Article R11480, “All About Tabs3 Connect”. If you need additional user licenses, please contact
your local consultant or our Sales Department at (402) 419-2200.

Figure 13, Tabs3 Connect Settings window

Figure 14, User Configuration window
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Figure 15, Download Files via Tabs3 Connect Access Right

Configuring the Exchange Connector
When your firm is configured to synchronize PracticeMaster and Outlook using an Exchange server,
enabling the PracticeMaster Exchange Connector creates a direct link between the Platinum server
and the Exchange server. This feature has several benefits, including:
l

l

l
l

l

l

PracticeMaster and Outlook stay synchronized, even when PracticeMaster is not open on
your workstation.
Only one “administrative” Exchange user needs access rights to other users, thus eliminating
the need to assign Editor rights to all users.
Periodic synchronization occurs on the server, thereby reducing network traffic.
The Exchange Connector performs a single periodic synchronization for all users, ensuring
that everyone is up-to-date.
Access rights to users’ Exchange folders are automatically assigned to the “administrative”
user as they log into PracticeMaster.
Only requires that PracticeMaster be running on one computer in the office for
synchronization to occur for all users.

Detailed instructions for configuring the Exchange Connector can be found in our Knowledge Base
in Article R11596 - “Configuring the PracticeMaster Platinum Exchange Connector” at
support.Tabs3.com.
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Configuring Platinum SQL
Platinum SQL includes two additional features that require configuration:
l
l

Data Encryption
SQL access via ODBC

Data Encryption
The Platinum SQL Data Encryption utility is used to encrypt Tabs3 and PracticeMaster data files that
may contain sensitive information. Once data files are encrypted, they can only be read by the Tabs3
and PracticeMaster Platinum SQL software. You can determine the current encryption status of the
software by checking the Data Encryption field of the Help | About window. See KB Article R11758,
“Information in the Help | About Window“ for more information.
See Knowledge Base Article R11660, “Platinum SQL Data Encryption” for more information on the
Platinum SQL Data Encryption feature, including steps for enabling or disabling encryption.

ODBC Access
Platinum SQL software includes an SQL ODBC driver. This driver allows a variety of third-party
programs, such as Microsoft Access or Crystal Reports, to query the Tabs3 and PracticeMaster
database. The Platinum SQL ODBC driver has the following advantages:
Accelerated SQL Processing

Platinum SQL provides significantly faster reports when
using ODBC-capable software. The standard ODBC driver
for Tabs3 software processes all queries at the workstation,
meaning that all of the data is sent to the workstation via
the network and then filtered based on the query. With
Platinum SQL, all queries are processed at the server, and
only the results are returned over the network, improving
performance and reducing network load.

64- & 32-bit Access

The SQL ODBC driver included with the Platinum SQL
software is available in both 64-bit and 32-bit versions.
This allows you to access the Tabs3 Billing and
PracticeMaster database from 64-bit and 32-bit programs.
Users with 64-bit workstations can install both drivers, and
will only need to configure the ODBC data source once.

Firm-wide License Included

The license for the standard ODBC driver is purchased per
workstation. The ODBC driver included with the Platinum
SQL software is licensed for use by the entire firm. The
ODBC SQL driver is included at no extra charge.
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Microsoft SQL Server Access via
OLE DB

Platinum SQL supports OLE DB access. In addition to
standard ODBC access, Tabs3 Billing and PracticeMaster
data is also accessible from OLE DB compatible software
using the Microsoft OLE DB Provider for ODBC. This
includes Microsoft SQL Server software.

For information on installing the ODBC drivers and configuring Platinum SQL for ODBC access, see
KB Article R11397, “Working with Platinum SQL ODBC Drivers“ or the “Operating Platinum
SQL Server“ section of the Platinum Server Product Guide.
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Other IT Considerations
Your IT professional or office manager should be aware of the following information.

Backup Best Practices
Tabs3 software includes a built-in backup feature. In addition to using the built-in backup, it is
important that you implement another backup method. A thorough discussion of the backup
options can be found in Knowledge Base article R11213 - Backup Strategy.

Power Management Settings
Certain power management features on computers have been known to cause problems on servers
or computers and can cause lost connections. Review your power management settings for the
server and all workstations that use Tabs3 software, and make sure they are set to Never Sleep.
When a computer goes into Sleep Mode, the connection to the server may be lost. This may result in
the user remaining logged in, and thus requiring a reset. Additional information regarding power
management settings can be found in Knowledge Base article R10339 - Power Management Issues
with Tabs3 and PracticeMaster Software Products.

NIC Drivers
Network Interface Cards (NIC) can cause problems if the most current drivers are not installed.
Always make sure the latest NIC driver is being used. Current drivers are typically available from the
manufacturer of your NIC card. Knowledge Base Article R10184 discusses these problems and
others in depth.

VSS - Volume Shadow Copy Service
Volume Shadow Copy Service (VSS) can be used to back up Tabs3 and PracticeMaster Platinum
software. Complete details can be found in Knowledge Base Article R11430 - Using Volume Shadow
Copy Service (VSS) to Back Up Tabs3 and PracticeMaster Software.

Tabs3 Network Utilities
Tabs3 includes two network utilities that can be useful for troubleshooting purposes.
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Network Settings Utility

A Network Settings utility is built into the software and
can be accessed via the Help | Diagnostics menu. This
utility tests your server for various Windows Server
settings. Knowledge Base Article R11309, “Network
Settings Technical Information,” provides details regarding
this utility program.

Network Test Utility

If you are having problems with errors, lockups or data
corruption on your network, a Network Test utility is built
into the software and can be accessed via the Help |
Diagnostics menu. This utility can be used to test for basic
network reliability. Knowledge Base Article R11304, “All
About Network Test,” provides details regarding this utility
program.

Network Troubleshooting Guide
It can be difficult to diagnose network problems. Knowledge Base article R10184, Network
Troubleshooting Guide, contains information that can be used to help diagnose a problem more
efficiently with regards to using Tabs3 software in a networking environment.

Security
Tabs3 software offers multiple layers of security, thus allowing you maximum flexibility when
assigning which users have access to information. An overview of the various security features can
be found in the Administrator Guide and in Help.
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Other Installation Scenarios
This section includes information on other installation scenarios that may occur after the initial
installation.

Updating the Software
Periodically, updated versions of the software are posted on our download site on the Internet.
These updates are available to firms who are on maintenance. We will notify firms when there is a
new version of the software. Alternatively, users can check for updates via the Help | Check for
Updates menu option. Once downloaded, follow the on-screen instructions to install the updated
software.
Once the software is installed on the server, the next time each workstation starts the software, the
software will automatically update the program files from the server onto the workstation.
You can read more about Tabs3’s automatic update notification process in KB article R11539 Tabs3 and PracticeMaster Update Notification.
Platinum Note: Not all updates require being installed at the server. You will be informed if a
particular update requires that it be installed from the server.

Reinstalling the Software
All Tabs3 software is licensed and is provided with a serial number. You may need to reinstall the
software due to an upgrade, software license transfer, firm name change, etc.
Step-by-step procedures for reinstalling the software can be found in KB article R11573 - How to
Reinstall Tabs3 and PracticeMaster Software.
Tabs3 Remote & Cost Recovery Interface Integration Note: If you are reinstalling Tabs3 software
due to an upgrade, software license transfer, firm name change, etc. (i.e., you have a new Tabs3
Billing serial number), make sure you merge any remote data files, cost recovery system data files,
and handheld integration files before reinstalling Tabs3. Otherwise the previously entered
information cannot be imported.
Terminal Services/Citrix Note: The SETUP.EXE file will only need to be run once by a Terminal
Services computer, no matter how many users log onto the workstation remotely. Details on this
process for Terminal Services/Citrix workstations can be found on page 14 as well as in KB Article
R11284, Using Tabs3 and PracticeMaster Software on Terminal Services or Citrix.
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Converting the Software
When updating to a new version, a conversion is generally required. Although you will be provided
with step-by-step instructions when converting to a newer version, detailed instructions for
converting from older versions can also be found in our Knowledge Base at
support.Tabs3.com/main/convmain.htm.
Additionally, you can find links to additional conversion materials for Version 19 in the following
Knowledge Base article, R11746 - Version 19 Information & Resources.

Installing Full Software for Use with Trial Software
Data
Many firms use the Trial Software to store live data in order to evaluate the products in a realistic
setting. Once you purchase the Tabs3 software license, you may want to use the data you have
already entered to save time. By default, the installation program will prevent you from installing the
full version over an existing Trial Software installation. However, you can use the procedures
provided in Knowledge Base article R10341 - Trial Software Information, to install the full software
while retaining your existing data.

Moving the Software to a New Computer
If you need to move the Tabs3 software from one computer to another computer, use the
procedures in the following Knowledge Base articles:
l

R10838 - Moving Tabs3 and PracticeMaster Software

l

R11624 - Moving Platinum Software

Uninstalling the Software
If you want to remove the software from the hard drive, use the following procedures:
▶ To remove the software
1. From the Control Panel, select Add/Remove Programs.
2. Select Tabs3/PracticeMaster Local Installation, Tabs3/PracticeMaster Programs or
Tabs3/PracticeMaster Icons, whichever is present. Selecting Tabs3/PracticeMaster
Programs will remove the program files but not the data files. Selecting
Tabs3/PracticeMaster Icons will remove the shortcuts only.
3. Follow the on-screen instructions.
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Note: The data files are not deleted. This is by design. You can manually delete these files after
uninstalling the programs using Windows Explorer. Data files are located in the program folder
specified when the software was installed. If you are not sure where this is located, you can start
the software and select Help | About, which will show the Current Working Directory. You can
also open the Current Working Directory in Windows Explorer by clicking the Open CWD button
in the Help | About window. If the software has already been uninstalled, you can search for
STUSER.DAT on the hard drive in order to locate the remaining data files. Additional details
regarding uninstalling the software can be found in our Knowledge Base in Article R11611 Uninstalling Tabs3 Software.

- 36 -

Tabs3 Software Installation Guide

Frequently Asked Questions
The following questions and answers are provided to help facilitate a successful implementation and
installation of the software.
Will the software run under Windows 10, Windows 8, and Windows 7?
Yes. Tabs3 software will run under Windows 10, Windows 8, and Windows 7. When running
as a Windows 10/8/7 stand-alone system or as a Windows 10/8/7 workstation that connects
to a Microsoft Windows Server 2016/2012/2008 R2 (either 32-bit or 64-bit), all functions can
be run with UAC enabled. Additional information is provided in Knowledge Base Article
R11238, “How Microsoft Windows Interacts with Tabs3 and PracticeMaster Software.”
Will the software run under Windows Small Business Server?
Yes. Tabs3 software will run under Windows Small Business Server 2011. However, installing
the Tabs3 software database on a domain controller may require special IT consideration
due to potential performance issues. Windows Server Essentials/Small Business Servers are
always domain controllers, and any Windows server can be configured as a domain
controller. Additional information can be found in the "Using a Domain Controller as the
Tabs3 Server" section of R11637 - Network Performance Guide.
How can I tell which version of Windows I am running?
You can press the Windows + Pause/Break keys together, or you can right-click the
Computer, My Computer, or This PC icon on your desktop and select Properties.
We are running on a network and intend to have multiple workstations use the software.
What is the installation procedure?
Be sure to use the instructions provided in this guide for complete details. To summarize,
however, you first install the software onto the server. Once the software is installed onto
the server, you then run the SETUP program off of the server’s hard drive from each
workstation that will be accessing the software.
How long does it take to install the software?
Installing the software onto the server takes less than 15 minutes. Allow approximately 5-10
minutes additional installation time for each workstation.
We know about the guides, help and Knowledge Base. Is there any other documentation
provided that we should be aware of?
Yes. There are several other documents we provide that you may be interested in.
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A “ReadMe” (READWSTI.HTM) file is provided with the software that contains late breaking
information that may not be available in other documentation.
Training videos are available for Tabs3 Billing and PracticeMaster. They consist of videos
with sound that are ideal for introducing unfamiliar features as well as providing training
for new personnel. The training videos can be run from within the software, accessed via
the software’s Help, or from the Web at Tabs3.com/videos.
Quick Guides are available for various PracticeMaster features. Quick Guides are short
documents that introduce features by focusing on what you need to know to get started.
These guides provide a useful alternative for users who need to start using the software
right away with a minimal amount of instruction or training. They are ideal for attorneys to
use as an introduction to the most commonly used features in PracticeMaster. Quick
Guides are provided as PDF files and can be accessed via the PracticeMaster Help |
Documentation menus or via Knowledge Base Article R11130, “PracticeMaster Quick
Guides.”
Report packs contain examples and detailed information regarding each report in the
software. Each report is broken down by field to explain exactly how the information is
represented. Each report consists of three sections: a sample report, the description of the
report, and field definitions.
A monthly newsletter is available that includes timely articles along with questions and
answers about the software. The easiest way to access the newsletter is from within the
software menu via Help | Internet Resources | User Newsletter or via
http://newsletter.tabs3.com.
Will our antivirus software cause any problems with the software?
We recommend excluding the directories where the Tabs3 software is installed from
continuous virus scanning in order to optimize performance and eliminate the potential for
runtime errors (page 8).
Do we need any special rights to install the software?
Yes. You must have Administrator privileges when installing the software or running the
SETUP.EXE program for workstations. Additional details can be found in our Knowledge
Base Article R11434, “User Rights Needed to Install and Use Tabs3 and PracticeMaster
Software.”
Do we need any special rights to run the software?
Yes. All users must have all rights to the program and data directories. Additional details
can be found in our Knowledge Base Article R11434, “User Rights Needed to Install and
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Use Tabs3 and PracticeMaster Software.”
Do we need any special rights to use PracticeMaster?
Certain settings are written to the Windows registry for several PracticeMaster features.
Therefore, in order to successfully install and use these PracticeMaster features, they must
be installed by a user who has Administrator credentials. If you are running the software
without these credentials, you will be asked to enter them at the time they are required.
These features include: Outlook Plug-in for email integration, Internet Explorer Plug-in,
Word Plug-in, Excel Plug-in, PowerPoint Plug-in, Adobe Plug-in, WordPerfect Plug-in,
HotDocs Document Assembly Plug-in, Word Document Assembly Plug-in, Worldox Plugin, Windows Explorer Plug-in, and ScanSnap.
Do we need to configure anything for printing?
You can print to any Windows printer that is available on your computer. You can specify
which font you want used (File | Print Setup). An Advanced Printing Features button in
Print Setup lets you configure more advanced settings such as whether you want to use
footers, commas, gray shading, gray text and lines, red text as well as other printing
options. Some firms will configure different printers if they will be using different fonts or
settings for statements or checks. Knowledge Base Article R10776, “How to Set up
Separate Printer Configurations for the Same Printer,” contains details regarding when you
might want to do this and detailed procedures for setting up separate printer
configurations for the various versions of Windows.
What if I have problems installing the software?
Information on how to troubleshoot installations can be found in Knowledge Base Article
R11277, “Troubleshooting Tabs3 and PracticeMaster Installations.” If this article does not
resolve your problem, call our Technical Support Department at (402) 419-2210.
We have been using the trial version of Tabs3 and recently purchased the software. We want
to use the data that we created during the trial period with our full-user version. How can we
do this?
Procedures to use data entered in the trial version can be found in Knowledge Base Article
R10341, “Trial Software Information.”
We have been using Tabs3 for some time and have just purchased PracticeMaster. Is there
anything we need to know regarding the installation of PracticeMaster?
Make sure all users are out of Tabs3 Billing when PracticeMaster is installed. Also, when
asked if you want to install starter data during the installation process, select Yes so the
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calendar codes and report writer definitions are installed.
After installing the software on the server, you can run the SETUP.EXE program located on
the server from the other workstations to create PracticeMaster desktop shortcuts.
Once PracticeMaster has been installed, start it up. The Customization window will be
displayed. Save the default customization settings. Then run the “Synchronize PM &
Tabs3/TAS” program in PracticeMaster to synchronize your Tabs3 Billing data to
PracticeMaster.
While working in the software, I received a message indicating that system activity
information had been reset. When I clicked the OK button, the program automatically closed.
Why?
Someone reset your User ID while you were actively using the software. Knowledge Base
Article R10789 - “Resetting Users” discusses when it is, and when isn’t appropriate to reset
users, and why this can cause a problem. It is very important that all users in the firm be
educated regarding the unnecessary issues that can occur when users are reset while they
are still in the software.
We have several employees who want to integrate PracticeMaster with their smartphones.
What do you recommend?
Users of Tabs3 Billing and PracticeMaster Platinum can access their data from anywhere
they can access the Internet using Tabs3 Connect. Tabs3 Connect is a Web-based
application that allows users to sign in to an easy-to-use interface for their Tabs3 and
PracticeMaster data. Tabs3 Connect allows touch or mouse-based interaction, and is
designed to work with both handheld and tablet (or larger) screen formats.
Additionally, PracticeMaster has the ability to integrate with smartphones via Microsoft
Outlook. Contacts and calendar records can be synchronized using the Outlook Integration
feature. See Knowledge Base Article R11734, “Integration between PracticeMaster and
Mobile Devices through Outlook,” for more information.
What is the Platinum version of the software?
Tabs3 and PracticeMaster Platinum are the top of the line products offered by Software
Technology, LLC. These programs utilize state of the art database technology to ensure the
fastest performance and lowest network impact possible. They also include advanced
reporting options, administrative tools, and mobile access to your Tabs3 and
PracticeMaster data. Auto-Recovery, HotBackup, Accelerators, and the Log Off Users
features all work together to enhance the overall usability, performance, and reliability of
the software. Tabs3 Connect provides access to Tabs3 and PracticeMaster anywhere you
can connect to the Internet. PracticeMaster Platinum also includes eNote, an intra-office
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messaging feature, and an Exchange Connector, which allows you to synchronize
PracticeMaster calendars and contacts with Outlook via Microsoft Exchange without
logging into PracticeMaster. As your firm grows, Platinum will scale with you, limiting
degradation in performance caused by processing increasing amounts of data.
For more information on the Platinum version of the software, contact the consultant from
which you purchased the software or our Sales Department at (402) 419-2200. Additional
information can be found in Knowledge Base Article R11379, “Platinum Software
Overview”.

What’s Next
Once the software is installed, use the Administrator Guide to configure the software.
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Resources
The best resource for the software is using F1 or the Help menu while in the software.

Figure 16, Help menu

The following table includes other available resources:

Resource

Location

Guides

Help | Documentation
...or....
Tabs3.com/docs
...or....
Tabs3.com/support/docs.html

Knowledge Base

Help | Internet Resources | Knowledge Base
...or...
support.Tabs3.com

Training Videos

Help | Training Videos
...or...
Tabs3.com/videos

Help Resources

R11194 - Help Resources: How to Find It

Technical Support (402) 419-2210
Sales

(402) 419-2200
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NIC Drivers
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See Network Interface Cards (NIC)
Installation
installing to a hard disk
installing to a network workstation
notes regarding terminal services
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IT Considerations
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Network Troubleshooting Guide
power management settings
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VSS
See Volume Shadow Copy Service (VSS)
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